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NOTICE 

��This instrument must not be modified, and products other than those manufac-
tured by JEOL Ltd. must not be attached to this instrument, without prior writ-
ten permission. If any such modification or attachment is made, all the stipu-
lated warranties and services contracted by JEOL Ltd. or its affiliated company 
will be void. 

��Replacement parts for maintenance of the instrument performance are available 
for seven years from the date of installation. Thereafter, some of those parts may 
be available for a certain period of time, and in this case, an extra service charge 
may be applied for servicing with those parts. Please contact your JEOL service 
office for detail. 

��The information in this manual, which is based on specifications believed cor-
rect at the time of publication, is subject to change without notice due to im-
provements made in the instrument. 

�� In order to assist us in preparing future documentation, please advise your near-
est JEOL service office if you find any errors in this manual. 
Kindly note that while the instrument can be used in combination with various 
attachments to serve a number of purposes, this special feature of the instrument 
is only briefly described in this manual, which chiefly provides information on 
basic operations. 

�� In no event will JEOL Ltd. be liable for direct, indirect, incidental or conse-
quential damages resulting from the use of software described in this manual. 

��This manual is copyrighted. All rights are reserved. This document may not, in 
whole or part, be copied, photocopied, reproduced, translated or reduced to any 
electronic medium or machine readable form without prior consent, in writing, 
from JEOL Ltd. 

��When this manual or the software described in this manual is furnished under a 
license agreement, it may only be used or copied in accordance with the terms 
of such license agreement. 
 

Copyright � 2002 JEOL Ltd. 
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NOTATIONAL CONVENTIONS AND GLOSSARY 

■ General notations 

 WARNING : A potentially hazardous situation which, if not avoided, could result 
in death or serious injury. 

 CAUTION : A potentially hazardous situation which, if not avoided, could result 
in minor injury or material damage. 
Material damage includes, but is not limited to, damage to related 
devices and facilities, and to acquired data. 

— CAUTION — : Points where great care and attention is required when operating the 
device to avoid damage to the device itself. 

�: Additional points to be remembered regarding the operation. 

�: A reference to another section, chapter or manual. 

1, 2, 3 : Numbers indicate a series of operations that achieve a task. 

◆ : A diamond indicates a single operation that achieves a task. 
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1 GENERAL 

 
This program is used for the JXA-8100/8200 series electron probe microanalyzers in 
order to perform fully automatic operations for particle analysis, such as (1) moving the 
sample stage to the analysis area, (2) collecting backscattered electrons, (3) analyzing 
particles, (4) analyzing elements of the particles found and (5) determining chemical 
types based upon the chemical composition. This program enables you to simultaneously 
obtain the quantity of particles and the elements of the particles. 
 
 

2 SPECIFICATIONS 
Measurement area: Areas of up to 100 � 100 (a maximum area of 10,000 can 

be specified) 
Image signal to be captured: Backscattered or secondary electrons generated by 

electron beam scanning 
Number of pixels of image signal: 

Maximum 1,024 � 1,024 pixels, 16-bits wide 
Size of pixel: Variable according to electron-beam scanning 

magnification 
Point analysis: Qualitative analysis (WDS or EDS), Semi-quantitative 

analysis (WDS or EDS) and Quantitative analysis 
(WDS/EDS combined) can be specified. 

Maximum number of analysis points per sample: 
10,000 points per measurement area 

Specifications for quantitative analysis 
   Number of measurement elements of an unknown sample: 

Maximum 30 elements in total with WDS and EDS 
   WDS X-ray measurement time: 

0.1 to 1,000 sec 
   EDS X-ray measurement time: 

1 to 10,000 sec 
   Correction calculation: ZAF correction for metals, ZAF correction for oxidized 

substances and other optional corrections can be selected. 
Specifications for semi-quantitative analysis with WDS or EDS 
 Number of measurement elements: 

Maximum 30 elements 
 Measurement elements: A-class elements are measured with the default condition. 

Measurement elements can be specified or eliminated by 
the user. 

Image display function: Level change 
Enlargement and reduction 
Selection of pseudo-color or gray scale 
Text input 
Reading in of the position and intensity at an arbitrary 
point in an image 
Measurement of the distance between two arbitrary 
points in an image 
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 Display of line analysis between two arbitrary widths in 
an image 
Displaying the point-analysis position on an image 
Point-analysis position coordinate transformation by 
mouse Average atomic-number image by 
calibration-curve factor 

Particle analysis function 
 Filter processing: Smoothing, median, sharpening, edge enhancement, 

shading correction, smoothing while retaining edges, 
arbitrary filter 

 Binarization: Automatic binarization by discrimination, manual 
binarization by histogram (the analysis area or the 
threshold value to be specified), multiple coding up to 7 
levels 

 Labeling: 4-neighbor or 8-neighbor labeling 
 Binarization filter processing: 

Removal of micro-particles, outline detection, filling of 
hole, particle separation, contraction, dilation, shrinking, 
thickening, thinning 

 Particle removal: Mouse designation, label number designation, area value, 
others 

 Particle measurement: Area, area %, stage position, perimeter, compactness, 
Heywood diameter, maximum angular distance and 
width, maximum length in x and y directions, Feret’s 
diameter in x and y directions, Euler’s number, moment, 
main axis and angle 

 Display on particles: Label number, maximum angular distance, Feret’s 
diameter, compactness, analysis coordinates 

 Histogram display: Histogram display of measured values. Cumulative 
frequency is also possible. 

 Point-analysis position saving: 
The stage position of the center of gravity of a particle. 
Number of point-analysis positions to be saved can be 
specified. Sorting by area or compactness is possible. 

 Maximum number of labeling operations: 
32,768 per image 

 
  

3 MENU TREE STRUCTURE 

File (Refer to Chapter 5.)  
Get image   
Show parameter 
Load image 
Save image   
Delete image 
Exit 

Operation (Refer to Chapter 6.) 
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Display mode 
Histogram 
Zoom 
Point analysis/coordinate-point display 
Line analysis 
Parameter 
Parameter color 
Text 
Calibration factor 

Particle analysis (Refer to Chapter 7.) 
Auto 
Run auto 
Particle undo 
   Original map 
   Binary map 
   Label map 
Filter 
Binarize 
Labeling 
Binary filter 
Delete 
Measurement 
Save stage 
Display 
Histogram 

Analysis (Refer to Chapter 8.) 
Analysis Condition 
   Group/Sample 
   EOS condition 
   Signal condition 
   Stage condition 
   Particle condition 
   Analysis condition 
   Flow control 
   Chemical type 
   Printout condition 
   Condition load 
   Condition save 
   Preset measurement 
Preset analysis 
Realtime monitor 
Start monitor 
Show 
   Stage position 
   Original map 
   Binary map 
   Label map 
Summary 
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4 OPERATION 

4.1 Outline of Operation 
The process of automatic particle analysis can be divided into the following four steps: 
(1) capturing an image signal, (2) executing particle analysis, (3) analyzing found 
particles and (4) determining chemical types based upon chemical composition. It is 
necessary to set parameters suitable for the operation you are going to perform, but most 
parameters do not have to be input again once they are set. After you have finished the 
parameter setting, specify the measurement area and carry out the calibration of a 
backscattered electron image signal. Then, you can leave the particle measurement to the 
automatic particle analysis function. 

 
This program consists of four menus: “File,” “Operation,” “Particle” and “Analysis.”  
��Using the File menu, you can manually capture an image signal, save the captured 

image or load a map image that has already been captured. The image data obtained 
with this automatic particle analysis function is compatible with map analysis data. 
Therefore, off-line particle analysis can be performed on the map images that have 
been captured with the usual measurement operations. 

��Using the Operation menu, you can operate on the displayed image in various ways. 
You can enlarge or reduce the image, display a histogram, perform a level change 
based upon the histogram, input text and carry out point analysis and line analysis.  

��Using the Particle menu, you can perform particle analysis manually and set the 
parameters required for automatic particle analysis. 

��Using the Analysis menu, you can determine the measurement area, specify the type 
of image to be captured, select the kind of point analysis and turn the realtime monitor 
on or off. 

 
The following are the general procedures for setting the conditions required to carry out 
automatic particle analysis using an actual sample. 

 
1. From the Analysis menu, select the group name and sample name whose 

measurement results are to be saved. 
2. Capture an image signal on the actual sample manually. At that time, adjust 

the image brightness and contrast. Also, select the magnification and the 
number of pixels according to the size of the particles you want to find. 

3. Select “Auto” from the Particle Analysis menu to display the “Auto” window 
for setting the parameters required for automatic particle analysis. Set the 
parameters in this window while carrying out particle analysis manually. After 
completing the parameter setting, try to run the analysis from the beginning 
and save the parameters in a file with a name attached. 

4. When you have developed a feeling of the particle analysis parameters, 
select the image signal type and electron optical condition for automatic 
particle analysis from the Analysis menu. 

5. Set the measurement area in the “Stage Condition” window selected from the 
Analysis menu. 
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6. When carrying out analysis, select the type of analysis and the analysis 
conditions that have already been set. In this Automatic Particle Analysis 
Program there is no routine for setting the analysis conditions for qualitative 
analysis, semi-quantitative analysis, quantitative analysis or other types of 
analysis. Therefore, set the elements to be analyzed and the other parameter 
items in advance, referring to the instruction manual for quantitative analysis, 
semi-quantitative analysis. 

7. Since chemical-type setting conditions are initially unknown, select “Learn 
Mode On” from the “Option” menu in the “Chemical Type” window. 

8. Select “Preset” from the Analysis menu and carry out analysis. 
9. When observing the measurement on the realtime monitor, click on “Start 

Monitor” in the Analysis menu 
 

Then, all the conditions for particle analysis have been established. So, record the 
conditions in a file and save it in the “Condition Save” window selected from the 
Analysis menu. For ordinary analysis, steps 1, 5 and 8 above are sufficient. 
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4.2 Starting and Terminating Program 

4.2.1 Starting Program 

Click on the Analysis icon in the EPMA menu, and the pull-down menu will appear. 
Click on “Online Particle Analysis” in the pull-down menu, and the “Particle Analysis” 
window will be opened, as shown in Fig. 4.1. 

 

 
Fig. 4.1  “Particle Analysis” window 

 

4.2.2 Terminating Program 

Click on the “File” menu shown in Fig. 4.1, and the pull-down menu will be displayed as 
shown in Fig. 5.1. Click on “Exit” in the pull-down menu, and the function and image 
display window shown in Fig. 4.1 and any other relevant windows, if opened, will all be 
closed. 
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5 FILE MENU 

Click on the “File” menu shown in Fig. 4.1, and the pull-down menu will be displayed as 
shown in Fig. 5.1.  
The following processing functions can be executed. 

 

Fig. 5.1  “File” pull-down menu 
 

5.1 Get Image 
Select “Get Image” from the “File” menu shown in Fig. 5.1, and the “Get ISD” window 
will appear as shown in Fig. 5.2. 
In this window you can select the kind of image signal, data points (number of pixels), 
magnification, brightness and contrast and the number of integrations. 
For the kind of image signal, select SEI (secondary electron image), COMP (backscat-
tered electron image), TOPO (topographic image) or AUX (auxiliary image). For the 
number of image data points, select 128, 256, 512 or 1024. When the image signal is SEI 
or BEI, adjust the image brightness and contrast by clicking on the “Cont./Bright.” 
button. For accumulation, select 1, 2, 4, 8, 16 or 32. When accumulation is 1, the 
maximum value of data is 2040. 

 
Click on the “Get Image” button in the “Get Image “ window. Then, image collection 
will begin. If you want to stop the image collection while it is in progress, click on the 
“Get Image” button again.  

 

Fig. 5.2  “Get Image” window 
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5.2 Show Parameter 
Select “Show Parameter” from the “File” menu shown in Fig. 5.1, and another window 
to display image-measurement conditions will be displayed. To close this window, click 
on the “Close” button. Select display items by clicking on “Parameter” in the 
“Operation” menu. When you want to indicate a color bar and a micron marker on the 
display window, select them by clicking on “Display Mode” in the “Operation” menu. 

 

 
Fig. 5.3  Image measurement condition window 
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5.3 Load Image 
Select “Load Image” from the “File” menu shown in Fig. 5.1, and the “Load Image” 
window will be opened as shown in Fig. 5.4. Select sample name, sample number and 
kind of signal in this window. When you want to change Group, click on the “Group” 
button.  
When you click on the “OK” button in the “Load Image” window (as shown in Fig. 5.4, 
for example), your selection of sample name “Rutubo (crucible)” No. 1 is finalized and 
the image is displayed, and then the “Load Image” window will be closed. 

 

 
Fig. 5.4  “Load Image” window 
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5.4 Save Image 
Select “Save Image” from the “File” menu shown in Fig. 5.1, and the “Save image” 
window will be displayed as shown in Fig. 5.5. Click on the “OK” button in the “Save 
Image” window, and the “Confirm” window will be opened. 
When you click on the “OK” button in the “Confirm” window (as shown in Fig. 5.5), the 
sample name is “Rutubo” and it will be saved as sample number Number 2. The element 
is added to the last of the existing elements. However, when you add an element to the 
existing file of elements, the number of pixels of the image to be saved must be 
consistent with the number of pixels of the file. It is possible to save up to 30 elements. 

 

 
Fig. 5.5  “Save Image” window 
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5.5 Delete Image 
Select “Delete Image” from the “File” menu shown in Fig. 5.1, and the “Delete image” 
window will appear as shown in Fig. 5.6. Click on the “OK” button in the “Delete 
image” window, and the “Confirm” window will be opened. 
When you click on the “OK” button in the “Confirm” window in the example of Fig. 5.6, 
the image of the sample name “Rutubo” Number 2, Element 2 will be deleted. 

 

  
Fig. 5.6  “Delete image” window 

 

 
 

5.6 Exit 
Select “Exit” from the “File” menu shown in Fig. 5.1, and the automatic particle analysis 
will finish, and then the relevant windows will be closed. However, the measurement 
window will not be closed. If the measurement is in process, click on the “Stop” button 
in the “Measurement monitor” window. 
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6 OPERATION 

Click on “Operation” on the menu bar shown in Fig. 4.1, and the pull-down menu will be 
displayed as shown in Fig. 6.1. 
Processing is performed for the current image. The following processing operations can 
be executed. 

 

Fig. 6.1  “Operation” pull-down menu 
 

6.1 Display Mode 
Select “Display mode” from the “Operation” pull-down menu shown in Fig. 6.1, and the 
“Display mode” window will appear as shown in Fig. 6.2. 
In this window, you can control window size, intensity or concentration, color or 
monochrome, number of display colors, place where to display color bar or micron 
marker and mesh display.   

 
Fig. 6.2  “Display mode” window 
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You can change the image size by selecting “Small,” “Middle,” “Large” or “Maximum” 
at the right of “Window size”. Also, the size of the image can be changed arbitrarily by 
dragging the bottom right corner of the window shown in Fig. 4.1. 

 
In the “Int/Conc” selection box, you can specify “Intensity Map” or “Mean 
Atomic-number Map” in the “Calibration Factor” window if the parameters A and B 
have been specified. 

 
In the “Display Color” selection box, you can specify “Pseudo Color” or “Monochrome 
Gray.” However, “Pseudo Color” is automatically selected for an image labeled with the 
particle analysis function. 

 
From the “Color number” selection box, you can select the number of display colors 
(number of levels). Select 8, 16, 32 or 64 colors. 

 
From the “Color bar” selection box, you can select the display position of the color bar. 
When you click on the “None” button, the color bar is not displayed. When you click on 
the “On Parameter” button, the color bar is displayed on the parameter window. When 
you click on the “On Map” button, the color bar is displayed on the right edge of the 
image. 

 
From the “Micron marker” selection box, you can select the display position of the 
micron marker. When you click on the “None” button, the micron marker is not 
displayed. When you click on the “On Parameter” button, the micron marker is displayed 
on the parameter window. When you click on the “On Map” button, the micron marker is 
displayed at the bottom left of the image. 

 
In the “Mesh” selection box, you can turn on and off the display of the mesh. The color 
of the mesh to be displayed can be specified in the “Color” window. 
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6.2 Histogram 

 

Fig. 6.3  “Histogram” window 
 
Select “Histogram” from the “Operation” pull-down menu, and the “Histogram” window 
will be opened as shown in Fig. 6.3. 
The window displays a histogram that is equally divided into 256 sections between the 
minimum and maximum values. The color level equally divided into 8, 16, 32 or 64 
colors between the minimum and maximum values is displayed. The histogram is 
enlarged or reduced when the arrow keys ▲▼ located on the right-hand side of the 
histogram are pressed. 

 
A new image having new levels is displayed by dragging the scroll bar and keying in the 
“Lower” and “Upper” values. By dragging the scroll bar, the color does not change while 
you are dragging the scroll bar, but it changes when you release the mouse button. 

 
You can read an arbitrary pixel value on an image using the “Pick up lower val.” and 
“Pick up upper val.” buttons and specify it as the minimum or maximum value. To use 
them, highlight these buttons and click on the image. The pixel value at that position will 
be shown on the scroll bar. 

 
When you click on the “Apply” button, level dividing is determined. Clicking on the 
“Cancel” button cancels the level dividing and returns the window to the previous 
window. 
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6.3 Zoom 
Select “Zoom” from the “Operation” pull-down menu, and the “Zoom” window will be 
displayed as shown in Fig. 6.4. 
There are two methods for zooming. One is to enlarge part of an image centered on the 
specified point by specifying the magnification desired (this method is called “Center”) 
and the other is to drag the mouse over the area you want to enlarge (this method is 
called “Outline”). 

 

 
Fig. 6.4  “Zoom” window 

 
When you select the “Center” button, click on the position of the image you want to 
display and click on the “Apply” button, the current image is enlarged, centered on that 
position, by the factor shown in the “Magnify” selection box. On the other hand, when 
you click on the “Outline” button, designate the area of the image you want to enlarge 
with the rubber band of the mouse and click on the “Apply” button, the designated area is 
enlarged. 

 
The “Cut” button is in effect when you select the “Outline” button. Its function is to 
displays the outside of the rubber band as having no data. Click on the “Level” button to 
re-calculate the maximum and minimum levels from the displayed image and display the 
re-calculated image. You cannot see the relation of colors with the previous image (prior 
to being enlarged) any more, but you can see much more detail of the color distribution. 
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6.4 Parameter 
Select “Parameter” from the “Operation” pull-down menu, and the “Display Parameter” 
window will be displayed as shown in Fig. 6.5. 
When you click on any item you want to display, the parameter corresponding to the 
selected item will be displayed on the “Parameter” window. When you want to remove it 
from the display, click on it again. To turn the color bar and micron marker on or off, 
click on “On” or “Off” in the “Display Mode” window. When you click on the “Apply” 
button, the selected items are displayed on the “Display Parameter” window. 

 

 

Fig. 6.5  “Display Parameter” window 
 



 

XM-17560-1  17 

6.5 Color 
Select “Color” from the “Operation” pull-down menu, and the “Parameter Color” 
window will be displayed as shown in Fig. 6.6. 

 

 
Fig. 6.6  “Parameter Color” window 

 
From the “Display Color” selection box, you can select pseudo color or gray scale. In the 
“Parameter Fore.” and “Parameter Back.” selection boxes, you can select the 
parameter-character color and parameter-background color respectively. These colors are 
used to display the “Parameter” window and micron marker. 

 
From the “Line Color” selection box, you can select the green color for line analysis. 
This color is also used as the mark color for point analysis. In the “Mesh Color” selection 
box, you can select the color to display the mesh.  
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6.6 Text 
Select “Text” from the “Operation” pull-down menu, and the “Write Text” window will 
be displayed as shown in Fig. 6.7. 

 

 
Fig. 6.7  “Write Text” window 

 
When you want to display text on the image, first, click on a position on the image. Then, 
input text in the “Write Text” window. When you want to attach a background color, 
select “On” from the “Background” selection box and then select a background color. 
When changing the letter size, select “S,” “M” or “L.” Clicking on the “Write” button 
will display the text on the image. When you want to change the position of the 
displayed text, click on the “Shift” button and then drag the text on the image. After the 
text is shifted, do not forget to release the “Shift” button. 

 
The “Clear” button is used to erase the text from the “Write Text” window. When you 
want to erase the text that has already been displayed on the image, use the “Delete” 
button. Clicking on this button will display a list of displayed texts. Selecting the text 
you want to delete will delete that text from the display screen. 
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6.7 Calibration Factor 
Select “Calib. Factor” from the “Operation” pull-down menu, and the “Calibration 
Factor” window will be opened as shown in Fig. 6.8. 
You can input the parameters A and B to convert a raw image to a mean atomic number 
image in this window. If the parameter A is 0, the mean atomic number is not converted.  

 

Fig. 6.8  “Calibration Factor” window 
 
The parameters A and B can be obtained by executing “Calibration” on the “Signal 
Condition” window in the Analysis menu (refer to Sect. 8.1.3). If “Calibration” has been 
performed, click on the “Default” button and the calibration result will be displayed. If 
the parameters A and B have already been input, click on the “Use Previous values” 
button to use the input values. 
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6.8 Point Analysis 
Select “Point Analysis” from the “Operation” pull-down menu, and the “Point Analysis” 
window will be displayed as shown in Fig. 6.9. 
The Point Analysis function enables you to measure the intensity at the desired point on 
the image, move the stage and the beam, and display the coordinates of the analysis point 
on the image. 

 

Fig. 6.9  “Point Analysis” window 
 
When you click or drag the mouse on the image, the stage position, beam position and 
beam intensity at that position will be displayed in the parameter display located at the 
top of the window. 

 
After clicking on the image, select “Drive Stage”, and the stage will move to that 
position. Selecting “Set Beam” will move the beam to the specified position. Use the 
“Center” button located at the bottom of the window to move the stage to the center of 
the image. When you want to confirm the analysis point after the measurement, move the 
stage to the center of the image by clicking on the “Center” button. 

 
By clicking on the “Show Point table” button, you can display the point analysis 
coordinates that are superposed on the image. In this case the “Coordinates” window 
shown in Fig. 6.10 is displayed at the same time. When you want to correct any 
coordinates displayed, click on the “Shift” button and drag the coordinates on the image. 
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Fig. 6.10  “Coordinates” window 
 
The “1 Point Analysis” and “9 Point Analysis” buttons are used to display the intensity at 
the specified point and the average value of 9 points around the specified point 
respectively. After clicking on a position on the image, click on the “Apply” button and 
these results will be displayed on the “Coordinates” window shown in Fig. 6.10. To 
display the distance between two points on the image, select “Apply” after dragging on 
the image. 

 
To change the point-analysis coordinates table to reflect these results, select “Point Table” 
in the “Coordinates” window (Fig. 6.10) and the “Coordinates Conversion” window (Fig. 
6.11) will appear. The “Update” button is used to correct the coordinates table. In 
practice, first, display the point-analysis coordinates by clicking on the “Show Point 
table” button; next, change the analysis coordinates using the “Shift” button; then click 
on this “Update” button. The “Append” button is used to add some more coordinates to 
the point-analysis coordinates table. The “New” button is used to replace the existing 
coordinates table with a new coordinates table. 
If “Beam” is selected in the “Type” selection box when you save a new coordinates table, 
the beam coordinates to which the new coordinates have been converted are saved. If 
“Stage” is selected, the X, Y stage positions to which the new coordinates have been 
converted are saved. 

 

 
Fig. 6.11  “Coordinates Conversion” window 
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When you want to erase the results of the point analysis or the distance from the display 
screen, click on the “Clear” button and the “Coordinates Clearance” window will be 
displayed as shown in Fig. 6.12. Clicking on any item listed will erase that item. To erase 
all the listed items, click on the “Clear All” button. Bear it in mind, however, that the 
“Clear ALL” function only deletes the display from the display screen and does not 
change the coordinates table.  

 

Fig. 6.12  “Coordinates Clearance” window 
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6.9 Line Analysis 
Select “Line Analysis” from the “Operation” pull-down menu and the “Line Analysis” 
window will be displayed as shown in Fig. 6.13. You can perform line analysis in the 
horizontal, vertical or desired directions. 

 

 

Fig. 6.13  “Line Analysis” window 
 
To perform line analysis in the horizontal direction, select “Line Profile (Hor)”; click on 
the image and drag the mouse continuously to determine the measurement width. When 
determining the measurement area, select the “Apply” button. If “On Map” is selected, 
the line analysis results that are superimposed on the image will be displayed. If “Result 
Window” is selected, the analysis results will be displayed in another window. 

 
To perform line analysis in the vertical direction, select “Line Profile (Ver)”; then repeat 
the same operations as described above. 

 
To perform line analysis in an arbitrary direction, select the “Line Profile (Arb)” button; 
next, click on the image to determine the center of the line; then, drag the mouse 
continuously to determine the direction of line analysis. When determining the direction, 
drag the mouse again to determine the measurement width. Clicking on the “Apply” 
button will display the line analysis results. 

 
To set the minimum and maximum values of the line analysis results, click on the “Min” 
and “Max” buttons. Then, you can adjust the amplitude of the line profile display. 

 
To erase the line analysis results, select “Clear.”  
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7 PARTICLE ANALYSIS 

To carry out automatic particle analysis, it is necessary to set the procedures for particle 
analysis. For that reason, execute particle analysis in the “Auto” window. 

 
To perform simple particle analysis, carry out image data analysis according to the 
following procedures. The menu items in the “Particle” pull-down menu are indicated in 
parentheses.  
��Binarization of image data (Binarize) 
��Labeling of a binarized image (Labeling) 
��Measurement of labeled particles (Measurement) 
��Saving the center of gravity of a particle in the coordinates table (Save stage) 

 
To perform somewhat complicated particle analysis, carry out image data analysis 
according to the following procedures. Of course, you sometimes have to change the 
procedures depending upon the state of the specimen.  
��Pre-processing of image data (Filter) 
��Binarization of image data (Binarize) 
��Labeling of a binarized image (Labeling) 
��Correction of a labeled image (Binary Filter) 
��Removal of unnecessary particles (Delete) 
��Measurement of labeled particles (Measurement) 
��Saving the center of gravity of a particle into the coordinates table (Save stage) 
��In order to execute elemental analysis after performing particle analysis it is 

absolutely necessary to save the center of gravity of found particles in the 
coordinates table. 

 
Click on “Particle” on the menu bar shown in Fig. 4.1, and the pull-down menu will be 
displayed as shown in Fig. 7.1. 
Particle analysis can be performed for the current image. The following processing can 
be executed. 

 

Fig. 7.1  “Particle” pull-down menu 
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7.1 Auto 
Select “Auto” from the “Particle” pull-down menu, and the “Auto” window will be 
displayed as shown in Fig. 7.2. 
Set the procedure for particle analysis in this “Auto” window. 

 
There is a menu bar indicating “File,” “Edit,” “Run,” “Reset” and “Close” on the top of 
the window. Menu buttons for particle analysis are shown on the left-hand side of the 
window. The buttons for the menu items that cannot be executed are indicated in a dim 
color.  

 

��For details of the menu items, refer to Sect. 7.2 and the subsequent sections. 
 

Shown on the right-hand side of the window is a list of particle analysis conditions that 
have been set. There is an On/Off toggle button on the left-hand side of each listed item. 
Only the listed items that have been selected with the toggle buttons are executed in 
particle analysis. 

 
When you first use the “Auto” function, select “New” from the “File” menu and then start 
particle analysis. The particle analysis commands executed immediately after “New” is 
selected are unconditionally added to the list. When you want to change the particle 
analysis conditions that have been established, click on one of the listed items and then 
click on “Edit.” Then, the “Replace command ?” confirmation window is displayed. 
When you want to insert a command into the list, click on the listed item that is just 
above the line in which you want to insert the command and click on “Insert” in the 
“Edit” menu. You can delete unnecessary items from the list by clicking on the “Delete” 
button in the “Edit” menu. 

 
When you select “Run,” the listed items are executed one after another, from top to 
bottom. The command that is being executed is highlighted. To go back to the original 
image, click on the “Reset” menu. 

 
There is another method for performing particle analysis. Select one of the listed items 
and then select “Single.” In this case, only the selected command is executed. 
Double-clicking on the listed item automatically executes the “Single” command. 

 

 

Fig. 7.2  “Auto” window 
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The following is the explanation of the “File” pull-down menu.  
  New:  Allows you to erase the existing commands and make 

new conditions. 
  Load auto conditions:  Allows you to read condition files that have been saved. 
  Save auto conditions:  Allows you to save the conditions with comments 

attached. 
  Delete auto file:  Allows you to delete unnecessary files from the saved 

condition files. 
  Close window:  Allows you to close this window. 

 

Fig. 7.3  “Load auto conditions” window 
 
The following is the explanation of the “Edit” pull-down menu. 
Click on one of the listed items in order to select the “Edit” menu. Then you can correct 
the selected command.   
  Edit: Allows you to correct the contents of the selected listed-item. When 

you select “Edit,” the command-operation window will be displayed. 
Operate the commands and click on the “Apply” button; then the 
“Replace command ?”confirmation window will be displayed. If you 
want to replace the command, click on the “OK” button. If you want 
to keep the command unchanged, click on the “Cancel” button.  

  Copy: Allows you to store the selected listed-item in the internal buffer. The 
listed item remains as it is. 

  Delete: Allows you to erase the selected listed item. The erased listed item is 
stored in the internal buffer. 

  Paste: Allows you to additionally insert the contents stored in the internal 
buffer just below the selected listed-item. 
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  Insert: Allows you to make an extra line just below the selected listed item. 
Is used to add an item to the list. After clicking on “Insert,” select this 
extra line; click on “Edit” and enter the contents to the line. 

 
The following is the explanation of the “Single” pull-down menu. 
This menu can be used only when one of the listed items is selected. When it is selected, 
only the selected items are executed. 

 
The following is the explanation of the “Run” pull-down menu item. 
This menu, when selected, returns the current image to its original image (regardless of 
the current image) and executes the items in the list one after another in the order from 
the first item down to the last in the list. 

 
The following is the explanation of the “Reset” pull-down menu  
  Reset to original map: Allows you to cancel the particle analysis results and 

returns the current image to its original image. 
  Reset to original binary: Allows you to return the current image to the first 

binarized image. Normally, this function is used to 
cancel “Binary Filter.” 

  Return to original label: Allows you to return the current image to the image 
when it had just been labeled. Normally, this function is 
used to cancel “Delete.” 

  Return to original condition: Allows you to return the particle analysis conditions to 
those which appeared when the window wass opened. 

 

7.2 Run Auto 
Click on “Run auto” in the “Particle” pull-down menu shown in Fig. 7.1, and a series of 
particle analysis commands shown in Fig. 7.2 (“Auto” window) will be executed. 
You can get the same result by clicking on the “Run” button in the “Auto” window shown 
in Fig. 7.2. 
 

7.3 Particle Undo 
“Particle Undo” in the “Particle” pull-down menu shown in Fig. 7.1 has a sub-menu 
consisting of “Original map,” “Binary map” and “Label map.” The current image is 
returned to its original image, binarized image or labeled image when you select one of 
them.  
  Original map: Cancels the particle analysis results and returns the current image to 

its original image. 
  Binary map: Returns the current image to the first binarized image. 
  Label map: Returns the current image to the image when it had just been labeled. 
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7.4 Filter 
Select “Filter” from the “Particle” pull-down menu, and the “Filter” window will be 
displayed as shown in Fig. 7.4. You can improve the image quality using this window. 
Select one of the following menu buttons to execute the menu item. 

 

 
Fig. 7.4  “Filter” window 

 
  Smoothing Filter: Allows you to perform smoothing without 3 � 3 

weighting. 
  Median Filter: Allows you to replace the value of each point with the 

5th largest (center value) of 9 points. 
  Sharpening Filter: Allows you to perform 3 � 3 filtering for sharpening an 

image. 
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  Edge Enhancement: Allows you to replace the value of each point by |b1| + 
|b2|, which is the sum of the absolute value of b1 and the 
absolute value of b2 in order to enhance the edge of an 
image,  
Where the nine points are labeled 

 
  and 

b1 = A + 2B + C – G – 2H – I, 
b2 = A + 2D + G – C – 2F – I. 

  Shading Correction: Used to perform Ohtsu’s discrimination analysis for each 
subdivision. Shading correction takes place on the spline 
curve that passes through a row of dots representing the 
threshold value. In some cases, the calculation takes 
several minutes. 

  Smoothing with Edge: Allows you to perform smoothing while retaining edges. 
Replaces the value of each point with the average value 
of the 5 � 5 pattern that has the lowest standard deviation 
of the nine types of 5 � 5 patterns used.  

  Defined Filter: Allows you to define an arbitrary 3 � 3 filter and perform 
weighting calculation. 

 

7.5 Binarize 
Select “Binarize” from the “Particle” pull-down menu, and the “Binarize” window will 
be displayed as shown in Fig. 7.5. You can binarize the data using the Binarize window. 
Click on one of the following menu buttons to execute the menu item.  
  Auto: Allows you to automatically perform binarization. When 

Ohtsu’s discrimination analysis is performed, the 
threshold value level is determined. 

  Manual (Region): You can manually perform “region designation” in 
which a pixel is turned on (white) for the region from the 
Lower value to the Upper value and off (black) 
otherwise (refer to Fig. 7.6). 

  Manual (Threshold): You can manually designate a threshold. A pixel is 
turned on (white) if its value is greater than the Lower 
value and is turned off (black) if its value is less than the 
Lower value. 
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Fig. 7.5  “Binarize” window 
 

 

Fig. 7.6  “Histogram for Binarize” window used for manual binarization 
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7.6 Multi-level Coding Using Multi ROI Window 
If you select Multi ROI in the Binarize window, you can identify the particles using 
multiple ROIs. In the Multi ROI window, you can color-code the intensity into up to 
seven levels. Level setting is carried out as follows:  
1. Allocating the desired color to the ROI 

When you click on the desired color button, the specified color is assigned to the 
active ROI, and three ROI setting markers appear to the right, in the center, and to 
the left of the ROI. You can change the range of the ROI by dragging the right-side 
marker or the left-side marker rightward or leftward. The marker in the center of the 
ROI is used for moving the entire ROI rightward or leftward. 

2. Recording the ROI settings  
Click on the Set button to record the above-mentioned ROI settings. 
If you want to delete a ROI that has been set, select it, then click on the Unset 
button. If you click on the All ROI Clear button, you cancel all the settings of the 
recorded ROIs. 
��Apart from the use of the Multi ROI window, you can specify the ROI directly 

using the image. To do this, click on the Pick up lower val. button or the Pick 
up upper val. button, then click on the point on the image that you want to 
make the lower or upper ROI limit. The signal intensities on this image are ac-
quired, and the corresponding ROI range can be set on the Multi ROI window.  

3. Using the Apply button 
Click on the Apply button after completion of these ROI settings. 
The results of multi-level coding are checked and displayed in the image display 
window for each color-coded ROI. 

��Refer to Fig. 7.7 Multi ROI window. 
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Fig. 7.7  Multi ROI window 

 
��Later, you may need to process data by comparing with the multilevel-coded data. 

In preparation for such a need, select ROI # in the Measurement window in advance. 
Data on the corresponding ROI is saved as one of the results of particle analysis. 

��If you intend to print the results only from the specified ROI after automatic particle 
analysis, set Sort in the Summary window to ROI#. You can set the ROI numbers of 
interest to Maximum and Minimum, allowing only the results of particle analysis 
for the desired ROI numbers to be printed. 

 

7.7 Current Correction for Binarized Deviation 
When binarizing the results of automatic particle analysis using the Binarize window, 
click on the Current correction button. The beam current used during the setting of 
analysis conditions is compared with the beam current used during data acquisition, and 
binarization is implemented with the beam current normalized to the value used during 
the setting of analysis conditions. 
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7.8 Labeling 
Select “Labeling” from the “Particle” pull-down menu, and the “Labeling of 
Binarized Data” window will be displayed as shown in Fig. 7.8. 
Labeling of binarized data is performed in this window. That is, each particle is 
numbered. 

 

 

 

Fig. 7.8  “Labeling of Binarized Data” window 
 
Click on one of the following buttons to execute the corresponding function.  
��“4 Connection” button 
��“8 Connection” button 

 
When carrying out labeling, specify either “4 Connection” or “8 Connection.” If you 
select “4 Connection,” particle bonding is determined in the up-down and left-right 
directions without including diagonal directions. If you select “8 Connection,” particle 
bonding includes diagonal directions as well. In the case of complicated particles, it is 
recommended that “8 Connection” be used, because you can reduce the number of 
particles and also reduce the execution time.  
��“Labeling (periphery included)” button 
��“Labeling (periphery not included)” button 

 
When performing the labeling of particles including peripheral particles, specify 
“Labeling (periphery included).” When performing the labeling of particles that do not 
include peripheral particles, specify “Labeling (periphery not included).” 

 
When labeling has been executed, each particle is colored and displayed. The coloring of 
each particle, starting from the top left particle, corresponds to each color shown on the 
color bar. 
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7.9 Binary Filter 
Select “Binary Filter” from the “Particle” pull-down menu, and the “Binary Filter” 
window will be displayed as shown in Fig. 7.9. 
In this window you can perform filtering of a binarized or labeled image and correct the 
particles. 

 

 

Fig. 7.9  “Binary Filter” window 
 
“Iteration Count” buttons (◄ ►)  

The numerical value between these two buttons ◄ ► is the number of iterations 
specified for filtering with the exception of “Inverse Map” and “Detect Outline.” 
Usually, it is set to a single-digit number. 

 
Click on one of the following buttons to execute the corresponding function.  
  Minute particles: Allows you to delete minute particles. 
  Inverse Map: Allows you to reverse the black and white parts of an 

image. 
  Detect Outline: Allows you to extract only the outline of particles. 
  Fill on Hole: Allows you to fill in holes in particles. 
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  Separation: Allows you to separate particles. 
  Erode: Allows you to erode particles. If all of a particle’s pixels 

disappear as a result of eroding, the corresponding 
particle disappears. 

  Dilate: Allows you to dilate particles. If two particles join due to 
dilation, they become one particle. 

  Shrink: Allows you to shrink particles. The resulting number of 
particles does not change. 

  Extend: Allows you to extend particles. The resulting number of 
particles does not change. 

  Thinning: Allows you to make particles thinner. 
  Clean: Allows you to erase something like an interference 

fringe that appears around a high-intensity area when 
you select the area during binarization. 
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7.10  Delete 
Select “Delete” from the “Particle” pull-down menu, and the “Delete Particle” window 
will appear as shown in Fig. 7.10. 

 
This window is used to delete binarized or labeled particles. Open this window and click 
or drag the mouse on the image. The particle number and the stage position will be 
displayed in the parameter display area located in the upper part of this window. After 
selecting any of particle measurement items, you can delete particles. 

  

 

 

Fig. 7.10  “Delete Particle” window 
 
Click on one of the following buttons to execute the corresponding function.  
  Manual Delete: Click on the particles you want to remove and then click 

on the “Apply” button. 
  Label No [ ]: Allows you to remove a particle corresponding to this 

number. 
  Area [ ]: Allows you to remove particles that are smaller than this 

area. You can remove large particles by setting the area 
value to a negative value. 

  Area % [ ]: Allows you to remove particles that are smaller than this 
area %. You can remove large particles by setting the 
area % to a negative value.  

  Delete Periphery: Allows you to remove peripheral particles. 
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  More. . .: Allows you to specify the removal of particles according 
to other conditions. Clicking on the “More. . .” button 
will display the “Particle Delete” window as shown in 
Fig. 7.11. 

  Unit: Allows you to specify the unit of an input numerical 
value. There are such units as Auto, Pixel, mm, �m and 
pm. Auto automatically selects either mm, �m or pm. 
Pixel indicates the number of pixels. Particularly, before 
entering a numerical value using Auto, it is 
recommended that you first measure particles according 
to Sect. 7.11 “Measurement” and confirm the unit used. 

  Digit of Fraction Part: Allows you to specify the number of digits of input 
numerical values after the decimal point. 

 
Click on the “More. . .” button in the “Delete Particle” window shown in Fig. 7.10 and 
the “Particle Delete” window will be displayed as shown in Fig. 7.11. 

  

 
Fig. 7.11  “Particle Delete” window 

 
You can also remove particles by specifying stage position, perimeter, compactness, 
Heywood diameter, maximum length in an arbitrary direction, maximum length in the X 
and Y directions, Feret’s diameter along the X and Y directions, Euler number, moments 
M11, M20, M02, and angle (degrees). Usually, you can remove particles that are smaller 
than the values specified here. If you enter a negative value, you can remove large 
particles in the same way as with the “Area” button.  
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  Stage Position [ , ]: You can remove particles at this stage position. 
  Perimeter [ ]: You can remove particles that have a smaller perimeter 

than this value. 
  Compactness [ ]: You can remove particles that have a smaller 

compactness than this value. 
  Heywood diameter [ ]: You can remove particles that have a smaller Heywood 

diameter than this value. 
  Max Length of any direction [ , ]: 

You can remove particles that have a smaller angular 
distance than this maximum length. 

  Max Length [ , ]: You can remove particles that have a smaller length than 
this maximum length.* 

  Feret’s diameter [ , ]: You can remove particles that have a smaller diameter 
than this value.* 

  Euler Number [ ]: You can remove particles that have a smaller number 
than this value. 

  Moment M11 [ ]: You can remove particles that have a smaller moment 
M11 than this value. 

  Moment M20 [ ]: You can remove particles that have a smaller moment 
M20 than this value. 

  Moment M02 [ ]: You can remove particles that have a smaller moment 
M02 than this value. 

  Angle (degrees) [ ]: You can remove particles that have a smaller angle than 
this angle to the main axis. 

 

                                                      
* Particles are removed when both of the X and Y values are sufficed. 
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7.11  Measurement 
Select “Measurement” from the “Particle” pull-down menu, and the “Measurement of 
Labeled Data” window will be displayed as shown in Fig. 7.12. 
If you click on the buttons corresponding to the measurement items, the measurement 
results are printed in the order in which you clicked on them. 

 

 

Fig. 7.12  “Measurement of Labeled Data” window 
 
Click on the buttons corresponding to the items you want to print.  
  Area: Allows you to print the area of each particle. A particle 

consisting of one point only has an area of 1 pixel or 1 � 
(data point spacing in the X direction) � ( data point 
spacing in the Y direction). 

  Area %: Allows you to print the area of each particle expressed as 
a percentage of all pixels.  

  Stage Position: Allows you to print the stage position [x, y] 
corresponding to the position of the center of gravity. 

  Perimeter: Allows you to print the perimeter. The perimeter of a 
particle consisting of one point only is 0. In computing 
the perimeter of a particle consisting two points or more, 
if there are two points in the X or Y direction, 1 is added, 
while if there are two points in an oblique direction, 
1.41421 is added. 

  Compactness: Allows you to print the compactness.  
Compactness = (4 �π� Area) / (Perimeter � Perimeter). 
The closer the particle is to a circle, the closer the 
compactness is to 1. A long thin particle has a small 
value in compactness. The compactness of a particle 
whose perimeter is 0 is calculated with the perimeter 
being 4. 

  Heywood diameter:   Allows you to print the Heywood diameter.  
Heywood diameter = 2 � )/Area( � . 
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  Any Max Length: Allows you to print the maximum length in any direction 
and the width in the vertical direction. 

  Max Length: Allows you to print the maximum lengths in the X and Y 
directions when the particle is scanned along the X and 
Y axes. 

  Feret’s diameter: Allows you to print the Feret’s diameter [x, y]. Feret’s 
diameter is the shortest length in the X and Y directions 
that can enclose a particle. 

  Euler Number: Allows you to print the Euler number.  
Euler number = (1 – the number of holes in a particle). 
The Euler number of a particle which has no hole is 1. 

  Moment M11: Allows you to print the Moment M11. If the coordinates 
of the center of gravity of a particle are (wX, wY) and 
the coordinates of a pixel are (xj, yi), 
Moment M11 = SUM ( (yi – wY) � (xj – wX) ). 

  Moment M20: Allows you to print the Moment M20.  
Moment M20 = SUM ( (xj – wX) � (xj – wX) ). 

  Moment M02: Allows you to Prints the Moment M02.  
Moment M02 = SUM ( (yi – wY) � (yi – wY) ). 

  Angle: Allows you to print the angle subtended between the X 
axis and the main axis (the direction in which the particle 
extends) in degrees (–90 � angle � 90). 

  ROI#: Allows you to print information on the ROI to which 
each particle belongs. This function takes effect only 
when you select Multi ROI in the Binarize window. 

  Output Unit: Allows you to specify the unit of the output value such 
as Auto, Pixel, mm, �m and pm. Auto automatically 
selects either mm, �m or pm. Pixel indicates the number 
of measurement points. Usually, �m should be selected. 

  Digit of Fraction Part: Allows you to specify the number of digits after the 
decimal point of the output numerical value. 

 
When you click on the “Apply” button shown in Fig. 7.12, the “Listing” window in 
which the results of measurement are printed will be displayed as shown in Fig. 7.13. 
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Fig. 7.13  “Listing” window 
 



 

42  XM-17560-1 

7.12  Save Stage 
Select “Save Stage” from the “Particle” pull-down menu, and the “Save stage for Point 
analysis” window will be displayed as shown in Fig. 7.14. 
If you have selected “Save stage,” you can save the center of gravity of a particle in a 
point-analysis coordinate file. If you want to save all the coordinates, select the “All” 
button. If you want to save some of the coordinates, select the “Partial” button and enter 
the number of coordinate pairs to be saved using the keyboard. If you deselect the “Save 
stage” button, you cannot save the coordinates. 

 
“Sort by” enables you to specify the order of saving. When you select “Area value,” you 
can save the coordinates in the order of area. When you select “Compactness,” you can 
save the coordinates in the order of compactness. “Sort order” enables you to specify the 
order of selection. When you have selected “Area value,” you can save the coordinates in 
sequence, from the largest number downward by clicking on the “Top” button, or from 
the smallest number upward by clicking on the “Bottom” button. Selecting the “Middle” 
button enables you to save the coordinates, both upward and downward, in sequence 
from the median value of area. When you select “Compactness,” on the other hand, since 
a particle with the best compactness is 1, you can save the coordinates in sequence, from 
the number closest to 1 by clicking on the “Top” button, or from the number closest to 0 
by clicking on the “Bottom” button. Selecting the “Middle” button sorts the coordinates 
in sequence from 1 and saves them from the median value. 

 
In the “Omit border” selection boxes you can exclude the particles existing around the 
image from the object to be saved. If you want to put some restriction on the size or 
compactness of the particle to be saved, select “Area value Thres.” or “Compactness 
Thres.” and specify the minimum and maximum values in the “Min” and “Max” input 
boxes. Only the particles that exist within the range specified here can be saved. 

 
Let’s take Fig. 7.14 as an example. Clicking on the “Apply” button causes the system to 
save the stage positions of up to 20 particles, and only those particles included in the 
particle area between the minimum and maximum values can be saved.  

 

Fig. 7.14  “Save stage for Point analysis” window 
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7.13  Display 
Select “Display” from the “Particle” pull-down menu and the “Display of Labeled Data” 
window will be opened as shown in Fig. 7.15. 
This window enables you to display the results of particle analysis superposed on a 
labeled image.  

 

Fig. 7.15  “Display of Labeled Data” window 
 
  Output Unit: You can specify the unit of output numerical values such 

as Pixel, mm, �m and pm. Auto automatically selects 
either mm, �m or pm. Pixel indicates the measurement 
points. Usually, �m should be selected. 

  Digit of Fraction Part: Enables you to specify the number of digits after the 
decimal point of the output numerical value. 

  Pseudo color: This is a toggle button used to select whether to display 
an image in pseudo color or in gray scale. 

  Line Color: You can specify the color of the line to be drawn. 
 

If you click on one of the following buttons, you can display measurement results 
superposed on particles.  
  Label Display: Allows you to superpose label numbers on particles. 
  Any Max Display: Allows you to superpose the maximum angular distance 

on particles. Selecting this button once again also 
displays, as a numerical value, the length of the 
maximum angular distance simultaneouly superposed on 
particles. 

  Feret Display: Allows you to draw rectangles that enclose the 
circumferance of a particle(s). 
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  Circle Display: Allows you to draw a circle with area equal to the area of 
a particle. 

  Measurement List: Allows you to open a text window on which to display 
particle analysis results. 

  Stage Display: Allows you to display the saved stage positions 
superposed on particles. 

  Shift: Used to correct the stage positions. When “Stage 
Display” has been selected, select “Shift” and drag the 
mouse over the coordinates of the image to correct the 
coordinates. 

  Update table: Used to update the coordinates corrected with the “Shift” 
function, and save them in a file. 

 
Fig. 7.16 shows an example of label numbers superposed on particles. Fig. 7.17 shows an 
example of the maximum angular distance superposed on particles. Fig. 7.18 shows an 
example of Feret’s diameters. Fig. 7.19 shows an example of Heywood diameter. Fig. 
7.20 shows an example of stage positions. These parameters are not stored in the 
computer memory as the commands for fully automatic particle analysis.   

 
Fig. 7.16  Label numbers 
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Fig. 7.17  Maximum angular distance 

 

 
Fig. 7.18  Feret’s diameters 



 

46  XM-17560-1 

 

Fig. 7.19  Heywood diameter 
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Fig. 7.20  Stage positions 
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7.14  Histogram 
Select “Histogram” from the “Particle” pull-down menu, and the “Histogram of Labeled 
Data” window will be displayed as shown in Fig. 7.21.  

 

Fig. 7.21  “Histogram of Labeled Data” window. 
 
Select one of the following functions:  
  Area: Histogram of the areas of the particles 
  Area %: Histogram showing the percentages of the areas of the 

particles against all the pixels 
  Stage Position: Histogram of the stage positions 
  Perimeter: Histogram of the perimeters 
  Compactness: Histogram of the compactnesses 
  Heywood diameter: Histogram of the Heywood diameters 
  Any Max Length: Histogram of the maximum lengths in any arbitrary 

direction 
  Max Length: Histogram of the maximum lengths of x and y 
  Feret’s diameter: Histogram of the Feret’s diameters of x and y 
  Euler Number: Histogram of the Euler Numbers 
  Moment M11: Histogram of the moments M11 
  Moment M20: Histogram of the moments M20 
  Moment M02: Histogram of the moments M02 
  Angle: Histogram of the angles (degrees) against the main axis 
  Output Unit: You can specify the unit of the output numerical value. 

The output units are Pixel, mm, �m and pm. Auto 
automatically selects either mm, �m or pm. Usually, �m 
should be selected. Pixel indicates the measurement 
points.  

  Digit of Fraction Part: Enables you to specify the number of digits after the 
decimal point of the output numerical value. 
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  Cumulative freq.: If this button is off, the vertical axis of the histogram 
shows the frequency of appearance. If it is on, the 
vertical axis shows the cumulative frequency of the 
histogram. 

 
By clicking on the “Apply” button in Fig. 7.21, you can obtain the histogram as shown in 
Fig. 7.22.  

 
Fig. 7.22  An example of an “Area % Frequency” histogram 

 
The histogram that appears when you select “Auto” in Fig. 7.22 displays the frequency of 
appearance obtained when the “Min” and “Max” value sections are equally divided into 
the number of colors and the interval size is displayed in the “Interval” button. If you 
select “Manual,” you can specify the interval size using the “Interval” button. In this case, 
an appropriate “Max” value is determined in the vicinity of the previous “Max” value 
from the “Min” value and the “Interval” value. When you input the “Max” value, you 
obtain a histogram in which the “Min” and the “Max” value sections are equally divided 
by the “Interval” value. In the displayed histogram, the labeled particle images are 
colored according to the histogram colors, thus enabling you to recognize the sizes of 
particles by color. 
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Fig. 7.23  Labeled images when an “Area” histogram is selected 
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8 ANALYSIS MENU 

Click on the “Analysis” on the menu bar in Fig. 4.1, and the “Analysis” pull-down menu 
will be displayed as shown in Fig. 8.1. 

 

Fig. 8.1  “Analysis” pull-down menu 

 
8.1 Analysis Condition Input Window 

Select the “Analysis Condition” button from the pull-down menu, and the “Particle 
Analysis” window will be displayed as shown in Fig. 8.2. 
You can set analysis conditions for fully automatic particle analysis in this window.  

 

Fig. 8.2  “Particle Analysis Condition Input” window 
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8.1.1 Group/Sample 

You can select or create group names and sample names. You can record multiple sample 
names under one group name. 

 
You can select sample names, record new sample names, delete sample names, change 
recorded names and print results by operating the buttons in the “Select Sample” window. 
Also, you can rearrange the sample names recorded in the list in alphabetical order or in 
the order of recorded dates by selecting “Name” or “Date” in the “Sorting Order” 
selection box. When changing the Group name, click on the Group button to display the 
Group window where you can select the desired Group name or record a new Group 
name. 

 
The functions of the buttons located at the bottom of the window are as follows.  
  “New” button: Allows you to record a new sample name. You can use 

up to 14 alphanumeric characters for a smple name. 
  “Rename” button: Allows you to change sample names. 
  “Delete” button: Allows you to delete sample names. Please note that data 

following sample names are also deleted. 
  “Print” button: Allows you to print a list of sample names on a printer.  

 
Fig. 8.3  “Select Sample” window 
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8.1.2 EOS Condition 

Click on the “EOS Condition” button in the “Particle Analysis Condition Input” window, 
and the “EOS Condition” window will be displayed as shown in Fig. 8.4. 
You can set the EOS (electron optics system) conditions in this window. When you open 
the “EOS Condition” window, the EOS conditions that were previously set will appear. 
To change any of the set conditions, click on the item to be changed and enter a new 
numeric value into the input box using the keyboard. 

 
Click on the “Set” button and the EOS conditions will be set. If you click on the “Read” 
button, the active EOS conditions will be read and displayed in the window. To set the 
current for measurement, first, select “Auto” and then, enter the current you want to set 
into the “Auto” input box using the keyboard. In this case, the CL (condenser lens) value 
is controlled so that the current becomes the specified value before the particle 
measurement is started. If you click on the “OK” button, the active EOS conditions will 
be recorded in a file. If you click on the “Cancel” button, the set values will be erased. 

 

 

 

Fig. 8.4  “EOS Condition” window 
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8.1.3 Signal Condition 

Click on the “Signal Condition” button in the “Particle Analysis Condition Input” 
window, and the “Signal Condition” window will be displayed as shown in Fig. 8.5. 
You can specify the kind of image signal in this window. When the image signal is a 
backscattered electron image (COMPO), you can perform the calibration to obtain the 
mean atomic number by clicking on the “Calibration” button.  
  Signal: You can select an image signal. Select one of the 

following image signals. 
    SEI (SL): Secondary electron image 
    COMPO (CP): Backscattered electron image 
    TOPO (TP): Topography image 
    AUX (AX): Auxiliary signal 
  Signal Accum.: You can specify the number of images to accumulate. 

The maximum number that you can specify here is 32. 
The maximum signal value obtained when accumulation 
is performed once is 2040. When accumulation is 
performed 32 times, the maximum value is 32 � 2040, or 
65280. 

  Cont./Brigh.: You can adjust the contrast and brightness of an image. 
To read in the active contrast and brightness of an SEI 
image, click on the “Read” button located at the bottom 
of the window. 

  Get ISD: An image signal is acquired. You can check if the 
contrast/brightness conditions are correct. 

 
Fig. 8.5  “Signal Condition” window 

 
If the signal is a backscattered electron image, you must carry out the calibration in order 
to use the mean atomic number to determine the binarization threshold levels.  
  “Use Calib.” button: This button must be pressed when you use a calibration 

value. The active calibration-curve factor is indicated 
under this button.  
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  “Calibration . . .” button: If you click on the “Calibration . . .” button, the 
“Calibration Condition” window will be displayed as 
shown in Fig. 8.6. 

 
Set two standard samples having different mean atomic numbers in this “Calibration 
Condition” window shown in Fig. 8.6.  
  Elem: Allows you to enter an arbitrary standard-sample name. 

If it is a simple element name, the mean atomic number 
is automatically calculated and displayed. 

  Z: Allows you to enter the mean atomic number.  
The calculation formula is  

 Z = Sum (concentration � atomic number). 
Note that the concentration is the value such that Sum 
(concentration) = 1. 

  X, Y, Z [mm]: Allows you to enter the stage position of the standard 
sample. The default is the coordinates that are recorded 
in the stage monitor. 

  Read: Allows you to read the active stage position as the stage 
position of the standard sample. 

  Int.: Allows you to indicate the intensity during calibration in 
�A. 

  Raw Int.: Allows you to indicate the raw intensity during 
calibration.  

 

Fig. 8.6  “Calibration Condition” window 
 
Clicking on the “Calib. Start” button starts the calibration. To carry out the calibration, 
first, the PCD (probe current detector) is closed and the sample current is read, then the 
PCD is opened and the stage is moved to the first standard-sample position; then the 
backscattered electron intensity is measured. Next, the stage is moved to the second 
standard-sample position; then the backscattered electron intensity is measured in the 
same way. A and B coefficients can be obtained from the mean atomic numbers and the 
intensities of the two standard samples, and a straight line is displayed on the graph as 
shown in Fig. 8.7. Note that coefficients A and B are normalized in �A. If you click on 
the “Re-plot “ button, the straight line that was previously measured is displayed. 
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Fig. 8.7  An example of “Calibration Curve” 
 

8.1.4  Stage Condition 

Click on the “Stage Condition” button in the “Particle Analysis Condition Input” window, 
and the “Stage Condition” window will be displayed as shown in Fig. 8.8. 
If the analysis region has already been recorded under the active sample name, the 
recorded analysis region will be displayed. In this window you can set the analysis 
region (the “Particle” button in the window), correct it by clicking on the “Pos. input” 
button or delete it by clicking on the “Clear” button. 

 

Fig. 8.8  “Stage Condition” window 
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■ Analysis area 
Click on the “Particle” button in the “Stage Condition” window shown in Fig. 8.8, and 
the “Image Condition Input” window will be displayed as shown in Fig. 8.9. 
Shown in Fig. 8.10 is the sequence for measuring an image in particle analysis. The 
image measurement in particle analysis is automatically performed sequentially in the 
numbered areas, and particle analysis is performed in each image. The scan method you 
can specify in this window is beam scanning. The movement from one analysis area to 
another is done by moving the stage. Fig. 8.10 shows the analysis areas appearing when 
acquisition of 3 � 3 images is specified. 

 

Fig. 8.9  “Image Condition Input” window 
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Fig. 8.10  A schematic of image measurement in particle analysis 

 
The functions of the buttons in the “ Image Condition Input” window are as follows.  
  X, Y Images: Allows you to specify the number of images to be 

acquired in the X and Y directions. The maximum num-
ber of images you can specify is 10,000 in total. 

  Comment: Allows you to input a comment. A maximum of 40 
letters can be input. The key words “Par xx-yy” are 
automatically displayed before the comments you input. 
Here, xx and yy are the numbers of lines in the X and Y 
directions. 

  Pixels: Allows you to specify the number of pixels in the X and 
Y directions. The minimum number of pixels you can 
specify is 128 and the maximum number is 1024. You 
can input any arbitrary integer from 128 to 1024, but in 
order to obtain accurate particle diameters you should 
select 128, 256, 512 or 1024. 

  Magnification: Allows you to specify the scanning magnification of the 
EOS system to be applied when you acquire images us-
ing the beam scan. The scan area per image is deter-
mined by this magnification. The minimum magnifica-
tion you can specify is 40 times and the maximum mag-
nification is 300,000 times. Magnification setting is also 
available in the EOS conditions, but the magnification 
you specify in this “Magnification” input box is used to 
acquire images. 

  Accumulation: The number of images to accumulate, which was 
specified in the “Signal Accum.” input box in the “Sig-
nal Condition” window shown in Fig. 8.5., is displayed 
here. 

  Beam Calib . . .: Allows you to obtain the correction factor of the EOS 
operation magnification and the stage position. For the 
detains of the calibration, refer to the next subsection. 

  Start, End: Allows you to indicate the measurement starting and 
ending points of the entire analysis area calculated from 
the above conditions. 
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  Dist.: Allows you to indicate the lengths along the X and Y 
axes of an image calculated from the above conditions. 

  Analysis area Working: Allows you to input the analysis points in this 
two-dimensional region. The measurement range is in-
dicated in the two-dimensional display area in which 
there are “Analysis area Working” lattices. A rectangular 
frame and ‘x’ are indicated inside the display area. The 
coordinates of the ‘x’ position are indicated on the 
right-hand side of the two-dimensional display region. 

 
■ Specifying the Analysis Region 

Set the analysis region in accordance with the setting of the scan range in the mapping 
analysis program. 

 

��For the setting details, refer to the instruction manual “Mapping Analysis Program,” 
Sect. 4.2.4a “Specifying Analysis Position.” 

 
The analysis area in particle analysis is a rectangle as shown in Fig 8.10. Point A is the 
starting point of analysis and point C is the ending point. The following is an example of 
inputs that are considered to be standard inputs.  
��Determine the scanning magnification in accordance with the size of particles you 

want to find. For example, when you observe an image with scanning magnification 
500 times and 512 pixels, the overall field of view is about 0.2 mm, and the length of 1 
pixel corresponds to about 0.4 �m. Therefore, if there is a particle that is 1 �m long or 
so, its length will be about two pixels.  

��Search for all the areas you want to measure using a secondary electron image, a 
backscattered electron image or an OM (optical microscope) image. 

��Then, move the stage to the starting point, the ending point or the center of the 
analysis area, and read the present position of the stage with the “Read” button. 

��Next, click on the “Store” button and select “Store to start,” “end” or “center” in 
accordance with the read position. 

��Click on the “Preview” button to check the overall analysis area. If the overall analysis 
area is not the desired area, repeat the third and fourth steps above. If the overall 
analysis area is not a square, you might have to correct the x and y maps. 

��When the overall analysis area has been determined, move the stage to the four 
corners of the analysis area using the “Preview” button and adjust the Z focus with the 
joystick. The value of the Z axis of each analysis area where the beam scan is to be 
performed is calculated from the value of the Z axis of point A, point B, point C and 
point D in the four corners. If you want to confirm the Z axis of each scan area, click 
on the “Confirm” button. 

 
When you have finished all the above operations, click on the “Apply” button and the 
conditions will be established and the scan conditions will be set to the scan-condition 
setting columns in the “Stage Condition” window shown in Fig. 8.8. 
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■ Correcting the scanning magnification and the stage position 
Click on the “Beam Calib. . .” button in the “Image Condition Input” window shown in 
Fig. 8.9, and the “Beam Image Calibration” window will be displayed as shown in Fig. 
8.11. 
You can obtain the correction factor of the scanning magnification and the stage position 
by carrying out the calibration in this window. The correction factor is recorded in the 
file /opt/epma/cali/eos/sgsp.cnd for each scanning magnification. The following is the 
procedure for carrying out the calibration.  
��Set the scanning magnification and look for a point that can be a mark while watching 

an actual image. 
��Click on the “Start Calib…” button. 
��A cross marker will be displayed on the top left corner of the first observation CRT. 

Move the mark under the cross using the joystick. When the stage position has been 
determined, press the “Store” button. Please note that you should use SLOW1 or 
SLOW2 as the scan speed. 

��The cross on the first observation CRT moves to the bottom right corner. Move the 
same mark as used in the third step above under the cross in the bottom right corner. 
When the stage position has been determined, press the “Store” button.  

��The calibration values in the X and Y axes will be calculated and the values in the X 
and Y axes will be updated.  

If you click on the “OK” button, the calibration values will be set. If you click on the 
“Cancel” button, the values will not be set. 

 

 

Fig. 8.11  “Beam Image Calibration” window 
 

8.1.5 Particle Condition 

Click on the “Particle Condition” button in the “Particle Analysis Condition Input” 
window, and the “Particle analysis condition load” window will be displayed as shown in 
Fig. 8.12. 
You can specify the conditions for particle analysis in this window. 
If you select “From Present Condition File,” you can use the present conditions for 
particle analysis. If you select “From Stored Condition File,” you can select the list of the 
stored conditions for particle analysis. So, select one condition from the list. When you 
click on the “Check” button, the “Auto” window will be displayed as shown in Fig. 7.2. 
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Fig. 8.12  “Particle analysis condition load” window 
 

8.1.6 Analysis Condition 

Click on the “Analysis Condition” button in the “Particle Analysis Condition Input” 
window, and the “Measurement Condition” window will be displayed as shown in Fig. 
8.13. 
In this window you can set the conditions for point analysis to be performed on the 
particles determined by fully automatic particle analysis.  
  Measurement: Allows you to specify execution or non-execution of the 

measurement for point analysis. 
    Yes: Allows you to execute the measurement for point 

analysis. 
    No: Does not allow you to execute the measurement for point 

analysis. In this case, point analysis is omitted and only 
particle analysis is executed. 

  Measurement Kind: Allows you to specify the kind of point analysis. You 
can select qualitative analysis, semi-quantitative analysis 
or quantitative analysis by EDS and WDS. 

    EDS Analysis: EDS qualitative analysis. The measurement conditions 
can be changed by clicking on the “Condition 
Change…” button. 

    EDS Semi-Quant.: EDS semi-quantitative analysis. The measurement 
conditions can be changed by clicking on the “Condition 
Change…” button. 
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    WDS Analysis: WDS qualitative analysis. The scan condition must be 
set in advance in the main window for qualitative 
analysis. 

    WDS Semi-Quant.: WDS semi-quantitative analysis. The scan condition 
must be set in advance in the main window for 
qualitative analysis. The measurement conditions can be 
changed by clicking on the “Condition Change…” 
button. 

    ED/WD Quantitative: ED/WD combined quantitative analysis. The 
measurement conditions must be set in advance in the 
main window for quantitative analysis.  

 

Fig. 8.13  “Measurement Condition” window 
 
  Condition Load: Allows you to read the recorded conditions for the 

measurement selected by the “Measurement Kind” 
button. You can select the active measurement 
conditions or read the conditions that are stored in 
advance. 

  From Present Condition Files: 
Allows you to use the active conditions that are being 
used now.  

  From Stored Condition Files: 
Allows you to use the stored conditions.  

If you click on the “OK” button, the conditions will be determined and the window will 
be closed. If you click on the “Check” button, the active conditions will be displayed. If 
you click on the “Cancel” button, the settings will be canceled. 
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Fig. 8.14  “Quant Condition File Load” window 
 
  Condition Change…: Clicking on the “Condition Change…” button in the 

“Measurement Condition” window shown in Fig. 8.13 
will display the “Change Measurement Conditions” 
window as shown in Fig. 8.15. You can change the 
following measurement conditions, depending upon the 
measurement kind. 

  EDS Analysis/EDS Semi-Quant: 
EDS qualitative analysis, EDS semi-quantitative analysis 

    EOS Condition: Electron optics system conditions 
    EDS Condition: EDS analysis conditions 
    Semi-Quant.: On-line semi-quantitative analysis conditions (used only 

when EDS semi-quantitative analysis is performed) 
    Print-out Condition: Print-out conditions 
  WDS Analysis/WDS Semi-Quant: 

WDS qualitative analysis, WDS semi-quantitative 
analysis 

    EOS Condition: Electron optics sysytem conditions  
    Semi-Quant.: On-line semi-quantitative analysis conditions (used only 

when EDS semi-quantitative analysis is performed) 
    Print-out Condition: Print-out conditions 
  ED/WD Quantitative: ED/WD quantitative analysis 
    EOS Condition: Electron optics system conditions 
    EDS Condition: EDS analysis conditions 
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    Standard Condition: Selection of standard specimens 
    Print-out Condition: Print-out conditions 

 

Fig. 8.15  “Change Measurement Conditions” window 
 

8.1.7 Flow Control 

Click on the “Flow Control” button in the “Particle Analysis Condition Input” window 
shown in Fig. 8.2, and the “Flow Control Switch” window will be displayed as shown in 
Fig. 8.16. 
You can temporarily stop the measurement during the measurement in fully automatic 
particle analysis when the number of particles has exceeded the specified value. When 
the measurement stops temporarily, the following dialog window will be displayed. If 
you want to continue the measurement, click on the “OK” button.  
Pause after processing particle: 

If “Pause” is selected, the measurement stops temporarily when the particle analysis 
finishes. If “Continue” is selected, the measurement automatically proceeds to the 
next processing when the particle analysis finishes. 

Pause before point analysis: 
If “Pause” is selected, the measurement stops temporarily before point analysis is 
begun. If “Continue” is selected, the measurement automatically proceeds to the 
next processing. 

Pause after point analysis: 
If “Pause” is selected, the measurement stops temporarily after point analysis is 
carried out. If “Continue” is selected, the measurement automatically proceeds to 
the next processing. 

Pre-measurement image: 
If “No” is selected, image acquisition and point analysis are executed one after the 
other. If “Yes” is selected, image acquisition is repeatedly done first, and point 
analysis is collectively performed later. 
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Skip point analysis: 
If “No” is selected, point analysis is executed. If “Yes” is selected, point analysis is 
not executed. 

Skip particle analysis measurement: 
If “No” is selected, particle analysis is executed. If “Yes” is selected, neither particle 
analysis nor point analysis is performed. 

Skip point analysis each point: 
If “No” is selected, point analysis is executed. If “Yes” is selected, point analysis 
stops at that moment and the measurement jumps to the next image acquisition. 

End if specified number is over: 
If “No” is selected, point analysis is executed. If you select “Yes,” specify the 
number of point analyses to finish the measurement. Then, check the number of 
particles measured. If the number of point analyses exceeds the specified number, 
the measurement finishes. 

End if specified type is over: 
If “No” is selected, point analysis is executed. If you select “Yes,” specify the 
chemical type and the number of point analyses. Then, check the number of parti-
cles measured of the specified chemical type. If the number of point analyses 
exceeds the specified number, the measurement finishes. 

 
If you select “Default,” the flow control does not function for any of the items. If you 
select “OK,” the settings take effect. If you select “Cancel,” all the selections are 
cancelled. 

 

Fig. 8.16  “Flow Control Switch” window 
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8.1.8 Chemical Type 

Click on the “Chemical Type” button in the “Particle Analysis Condition Input” window 
shown in Fig. 8.2, and the “Chemical Type” window will be displayed as shown in Fig. 
8.17. 
You can set or correct the chemical type in this window. You can also turn the Learn 
mode on or off. There is no limit to the number of the chemical type groups that can be 
recorded. You can specify up to 100 chemical types for each chemical type group. 

 

 
Fig. 8.17  “Chemical Type” window 

 
  “File” menu: Clicking on the “File” menu in the “Chemical Type” 

window shown in Fig. 8.17 will display a menu. You can 
specify or store chemical type groups. 

    Open. . .: Allows you to open a file of chemical type groups, 
enabling you to add new ones or changes existing ones. 

    Save: Allows you to save the chemical type conditions. 
    Save as. . .: Allows you to attach names to chemical type groups and 

saves them. 
    Printout. . .: Allows you to print the conditions and rule of the 

chemical type that is being edited now. 
    Close: Allows you to close the chemical type window. 
  “Apply” menu: Clicking on “Apply” in the “Chemical Type” window 

shown in Fig. 8.17 will display a menu.  
    Apply chemical type: Allows you to determine the chemical type. Used to 

check the measurement results. 
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    Update Learned type list: Allows you to load the chemical type that has just been 
learned based upon Apply chemical type. If there is a 
chemical type that was already learned, it is replaced by 
the one that has just been learned. 

  “Options” menu: Clicking on “Options” in the “Chemical Type” window 
shown in Fig. 8.17 will display a menu. You can change 
the chemical type determination parameters. 

    Configure. . .: Allows you to open the window to change the 
parameters used to process the chemical type. 

    Learn Mode On: Allows you to turn on or off the Learn mode during 
chemical type determination. 

    Show Learned Lists: Allows you to diplay a list of learned chemical types to 
the right of the window. If there is no learned chemical 
type, the list will not be displayed. 

  Chemical Group: Allows you to display the name of the chemical type 
group that is being selected now. 

  Comment: Allows you to display and allows you to edit a comment 
about a chemical type. Up to 40 characters can be input. 

  Chemical type list: Allows you to display a list of the registered chemical 
types. To edit or delete them, click on listed items to 
highlight them and then click on the “Edit. . .” or 
“Delete. . .” button. 

  Edit. . .: Allows you to display the window on which to edit the 
chemical types selected from the chemical type list. 

  New. . .: Allows you to display the window on which to enter new 
chemical types. 

  Delete. . .: Allows you to delete the chemical type selected from the 
list of chemical types. 

  Up: Allows you to move up the chemical type selected from 
the list of chemical types. 

  Down: Allows you to move down the chemical type selected 
from the list of chemical types. 

  >: Allows you to move the conditions of learned chemical 
types to the list of chemical types. 

 
Click on “Edit. . .” or “New. . .” in the “Chemical Type” window shown in Fig. 8.17 and 
the “Chemical Type Edit” window will be displayed as shown in Fig. 8.18. 
In this window you can change or edit the rules for each chemical type. You can register 
up to 100 chemical type rules for each chemical type group. 
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Fig. 8.18  “Chemical Type Edit” window 
 
  Type name: Allows you to specify the name to be attached to this 

chemical type. The maximum number of characters that 
can be used for naming is 64 alphanumeric characters. 
Spaces are not allowed. 

  Comments: Allows you to enter a comment for this chemical type. 
You can input up to 40 characters. 

  Chemical type rule list: Allows you to display the rule conditions registered in 
the chemical type list. Select a listed item (in the 
chemical type rule list) to change the rule of that item. 

  Keyword: Allows you to set the keyword for a chemical type rule 
(Spacesare not allowed). Usually, use an element name 
for the keyword. 
A simple calculation formula can be used. For example, 
you can judge the chemical type using a simple formula 
like Mg + Fe or Mg/Fe. 

  Type: Allows you to specify the operator for determining 
chemical types. The relationship between each operator 
and the condition is shown below. Note that v1 and v2 
are the specified numeric values, and Key is the keyword 
for a chemical type rule. 
Lower equal: v1 � Key 
Between: 1 � Key � v2 
Greater equal: v1 � Key 
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Equal: v1 = Key 
  Weight: Adds weight to each conditional formula. As described 

later, the differences from conditional formulas are 
calculated. According to the results, the assignment of 
chemical types are judged. 
Off: The raw values of differences are 

used. 
Normalize: Each conditional formula is equally 

weighed. 
× mag: Weight is added based on the values 

specified by the customer. This type 
of weighing is used in a formula for 
assigning trace elements.  

  Add: Allows you to add a new rule to the list. If the same 
keyword already exists, a warning will be displayed. 

  Change: Allows you to change the selected chemical type rules. 
  Delete: Allows you to delete the selected chemical type rules. 
  Delete All: Allows you to delete all the chemical rules.  
After setting these parameters, click on the “Apply” button to finalize the values. 

 
Click on the “Options” button in the “Chemical Type” window shown in Fig. 8.17 and a 
menu will be displayed. Then, click on “Configure. . .” in the displayed menu and the 
“Chemical Type Configure” window will be displayed as shown in Fig. 8.19. 

 
  Type Determination: Allows you to select the chemical-type determination 

conditions. 
Sort by delta value (d): 

Allows you to calculate the sum of the difference 
from each chemical type, and selects the chemical 
type having the smallest difference. 

Sort by no. of fit rules (r): 
Allows you to calculate the number of conditions 
met in each chemical type, and the largest number 
of conditions met is determined to be chemical 
type. 

Decision by faster rules (t): 
Allows you to determine the earliest one that 
satisfies the chemical type conditons as a 
chemical type. 

  Data Type: Allows you to determine the kind of data to be used for 
judgement. 

 Wt%: Weight percentage 
 Atom%: Atomic percentage 
 K-ratio: K ratio 
 Intensity: X-ray intensity 
  Include results of particle: When you want to include the results of particle analysis 

(such as area and area percentage) in the chemical type 
determination, highlight this button. 
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  Chemical Type Threshold: Allows you to specify the threshold to use to determine 
chemical types. The sum of the difference of each 
chemical type is calculated and the calculated value that 
is smaller than the value specified here (for example,10.0 
in Fig. 8.19) is judged to be the chemical type. 

  Permit value for rule (%): Allows you to judge chemical types with some 
allowance specified here added to the chemical type 
threshold specified for each chemical type. If you 
specify a larger value here, the rule condition becomes 
looser. 

 

 
Fig. 8.19  “Chemical Type Configure” window 

 
��How to judge chemical types 

Described below is the method for determining chemical type. In on-line particle 
analysis, first, you carry out particle analysis after acquiring an image; next, you search 
for the desired particles and move the electron beam to the particle positions; then you 
carry out the measurement (such as quantitative analysis and semi-quantitative analysis), 
by which to determine the chemical structure of the particles. You can determine the 
chemical types using this chemical structure of each particle. 

 
The following is the procedure for chemical type determination. 
Compare the analysis results (such as element name and particle measurement item) and 
the keywords registered as the rule conditions for each chemical type. Execute chemical 
type determination only when the keywords coincide with the chemical structure. For 
rule judgment, compare the numeric-value data of the analysis results (i.e. concentration) 
and the rule condition. If the concentration is within the range of the rule condition value, 
enter 0, and if the concentration is outside the range of the rule condition value, calculate 
the difference between the chemical structure and the rule condition value. Carry out this 
operation for all the rules registered for each chemical type and add the difference for 
each chemical type. After obtaining the sum of the differences, compare it with the value 
specified in “Chemical Type Threshold” shown in Fig. 8.19. If the sum of the differences 
is below the threshold value, it is determined to be the chemical type. 
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If multiple chemical types exist below the threshold value, chemical types are selected 
either from the smallest sum of the differences, from the largest number of particles that 
satisfy the rule conditions or from the earliest registered chemical type conditions. If the 
sum of the differences of all the chemical types exceeds the threshold value (in other 
words, if the chemical type cannot be judged), register the chemical structure itself as a 
new chemical type (when “Learn mode” is on). 
 

8.1.9 Printout Condition 

Click on the “Printout Condition” button in the “Particle Analysis Condition Input” 
window, and the “Printout Condition” window will be displayed as shown in Fig. 8.20. 
In this window you can set the conditions for printing out the results of the active 
measurement. 

 

Fig. 8.20  “Printout Condition” window 
 
The above figure contains a list of items to print. The items from “Area” to “Orient” are 
the measurement items in particle analysis. 

 

��For the details of these items, refer to Sect. 7.9. 
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Described below are the other items.  
  No.: Number of point analyses 
  Elements: Names and weight percentages are printed for up to three 

elements. 
  Type Name: Chemical type name  
  Map: Image number  
  Type No.: Number of chemical type 
  Type Value: Numerical value used for chemical type determination 
  Stage X,Y: Stage coordinates 
  Beam X,Y: Beam position coordinates  
The items are printed on a first-selected-first-printed basis. To change the order of 
printing, select listed items displayed in the lower part of the window and change them 
by clicking on the “Up” or “Down” button. When you print the items during actual 
measurement, a text window will be displayed in the upper right of the display screen 
and the printed items will be displayed in the text window as shown in Fig. 8.23. 
 

8.1.10 Condition Load 

Click on the “Condition Load” button in the “Particle Analysis Condition Input” window, 
and the “Condition File Load” window will be displayed as shown in Fig. 8.21. 
In this window you can call out the analysis conditions for fully automatic particle 
analysis that have already been registered, such as EOS Condition, Signal Condition, 
Analysis Condition, Flow Condition, Printout Condition and Chemical Type. Click on 
the analysis number you want to call out and click on the “Load” button, and then you 
can call out the analysis conditions of that analysis number.  

 
Fig. 8.21  “Condition File Load” window 
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8.1.11 Condition Save 

Click on the “Condition Save” button in the “Particle Analysis Condition Input” window, 
and the “Condition Save” window will be displayed. 
In this window you can record the analysis conditions for fully automatic particle 
analysis that you have set (such as EOS Condition, Signal Condition, Analysis Condition, 
Flow Condition, Printout Condition and Chemical Type) in a file. To store the analysis 
conditions in a new file, click on the “New” button; enter a file name and a comment; 
then click on the “OK” button. To overwrite on an existing file, select the file name and 
click on the “Save” button. 
 

8.1.12 Preset Measurement 

Click on the “Preset Measurement” button in the “Particle Analysis Condition Input” 
window, and the “Preset Measurement” window will be displayed as shown in Fig. 8.22. 
Clicking on the “Acquire” button will start measurement. Example windows during 
measurement are shown in Fig. 8.23. The top left window is a fully automatic particle 
analysis window, in which the state of particle analysis, the present beam position and so 
forth are being monitored. The bottom left window is a text window in which the results 
of EDS semi-quantitative analysis are displayed. The top right window is the one in 
which chemical type determination is displayed. A pie chart of EDS semi-quantitative 
analysis is displayed in the middle right window. The bottom right window is a monitor 
window showing the progress of measurement.  

 

Fig. 8.22  “Preset Measurement” window 
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Fig. 8.23  Windows during measurement 
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8.2 Preset Analysis 
Select “Preset Analysis” from the “Analysis” pull-down menu shown in Fig. 8.1, and the 
“Preset Analysis” window will be displayed. 
If measurement conditions have been established, you can start measurement in this 
window. In this case the realtime monitor is also turned on automatically. 
 

8.3 Realtime Monitor 
Select “Realtime Monitor” from the “Analysis” pull-down menu shown in Fig. 8.1, and 
the “Particle Analysis Realtime Monitor” window will be displayed as shown in Fig. 
8.24. 
In this window you can monitor the state of particle-analysis progress. When you are 
executing particle-analysis commands during fully automatic particle analysis, the 
commands are highlighted.  
  Original map: Allows you to display the original image. 
  Show stage pos.: Allows you to display the position of point analysis on 

an image. 
  Start monitor: Allows you to start the realtime monitor. 
  End monitor: Allows you to stop the realtime monitor. 
  Close: Allows you to close the window. 

 

Fig. 8.24  “Particle Analysis Realtime Monitor” window 
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8.4 Start Monitor 
Select “Start monitor” from the “Analysis” pull-down menu, and the realtime monitoring 
of fully automatic particle analysis will begin. Clicking on “Start monitor” again will 
stop the realtime monitoring. 
Once the realtime monitoring is started, the state of beam-image acquisition is monitored 
in real time while beam images are being acquired. Also, a binary image, a labeled image, 
point-analysis coordinates and so forth are displayed during particle analysis. During 
point analysis, the beam position is displayed as a small rectangular mark on the display 
window. 
 

8.5 Show 
You can display the original image, binary image, labeled image and stage-position 
coordinates in the display window.  
  Stage position: Allows you to display the point-analysis coordinates. 
  Original map: Allows you to display the original image. 
  Binary map: Allows you to display the binary image. 
  Label map: Allows you to display the labeled image. 
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8.6 Summary 
After you have finished the measurement, click on the “Summary” button in the 
“Analysis” pull-down menu shown in Fig. 8.1 and the “Summary ” window will be 
displayed as shown in Fig. 8.25. 
In this window you can make a summary of the results of qualitative analysis, 
semi-quantitative analysis and quantitative analysis and print the results of particle 
analysis. 

 

Fig. 8.25  “Summary” window 
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Click on the “Analysis” button in the “Summary” window, and you can select EDS 
qualitative analysis, WDS qualitative analysis, EDS semi-quantitative analysis, WDS 
semi-quantitative analysis, WD/ED quantitative analysis or particle analysis. When you 
print out the results of qualitative analysis, a list of the identified elements classified into 
A and B ranks is printed out. In addition, there are some more menus for particle analysis 
as follows.  
  Chemical type: Allows you to print out all chemical types and 

composition data, simultaneously. They are printed after 
the sample number is printed out. 

  Particle Analysis: Allows you to display a list of items for which particle 
measurement has been performed. Select the items you 
want to print out. They are printed out before element 
information is printed out. 

  Mass Order: Allows you to display a window on which to specify the 
number of elements you want to print out. The names of 
the elements and their weight percentages are printed in 
order from high to low values. This button (Wt. Order) is 
used when elements to be measured are not fixed as for 
example in semi-quantitative analysis. 

  Sort: Allows you to display a window on which to select 
elements to be sorted. In this window you can select 
elements in the order of weight concentration from high 
to low or in the order of particle size from large to small. 

  Histogram: Allows you to print the histogram distribution for each 
specified item. 
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8.7 Phase Analysis (Option) 
If you use the optional Phase Analysis program, you can combine particle analysis 
results and element measurement results. In the “Analysis” section of the “Phase 
Analysis” window shown in Fig. 8.26 you can additionally select WDS semi-quantitative 
analysis, EDS semi-quantitative analysis and particle analysis. If you select “Particle” 
(for particle analysis), you can process the measurement results of all the particles. If you 
select “Semi” (for semi-quantitative analysis) or “Quant” (for quantitative analysis), you 
can use the measurement results of the particles for which these analyses were performed. 
If you execute WDS semi-quantitative analysis, EDS semi-quantitative analysis or 
quantitative analysis in fully automatic particle analysis, selection items for particle 
measurement are added in the “Elements” window of “Phase Analysis“ shown in Fig. 
8.27.  

 
Fig. 8.26  “Analysis” section of “Phase Analysis” window 
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Fig. 8.27  “Elements” window of Phase Analysis 

 
In this window you can not only see the ordinary analysis such as the relationship among 
elements, but also combine the particle measurement results and the element information 
and process the combined results. For example, Fig. 8.28 shows the relationship between 
area and compactness in particle measurement, and Fig. 8.29 shows the relationship 
between area and element concentration. 
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Fig. 8.28  Display example of area and compactness 

 

Fig. 8.29  Display example of area and element concentration (Zn) 
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��Chemical Type window 
You can color-code and display the analysis results for each chemical type. Clicking on 
the Chemical type button in the Operation window of the Phase Analysis program 
displays the Chemical Type window (Fig. 8.30).  

 
Fig. 8.30  Chemical Type window 

 
The chemical types that appear are listed in the order of frequency of appearance (from 
high to low). If you wish to display only the selected chemical types, click on the Select 
chemical type button to select them, then on the Apply button.  
If you want to display the analysis results color-coded for each chemical type, click on 
the Colored by chemical type button and assign colors to the selected chemical types. 
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